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1 Introduction 
This document describes how to get started with application development and will take you through 
the following subjects: 

- How to install the development environment so you can successfully develop applications 
for Windows Embedded CE 6.0 R3 running on the Topaz platform 

- How to flash your Windows Embedded CE 6.0 R3 image1 to the Topaz 
- How to create, deploy and debug a simple managed application 
- Where to get more information 

 
The Topaz development kit comes with a pre-installed Windows CE image that will 
automatically run when you power up the board. You can power the board through 
the provided power adapter or by connecting a mini USB (type B) connector. Note 

that powering the Topaz through USB may not work (especially with a large LCD), 
depending on the amount of current your PC (or powered hub) can deliver. It is 
therefore recommended to always power the Topaz using a dedicated 5V power 
supply. 
 
It is important to check your device is running the latest version of the Windows CE image. GuruCE 
will release new images containing new features and bug fixes when needed. The latest version can 
always be found at this link: http://guruce.com/topaz/release/latest 

For instructions on how to upgrade the firmware in your device please read “Upgrading the 
firmware” below. 

2 Software Requirements 

2.1 Windows Embedded CE Application Development 
If you are developing an application targeting Windows CE 6.0 R3 running on the Topaz board you 
need: 

• Visual Studio 2008 with Service Pack 1 
Download the evaluation version from  
http://msdn.microsoft.com/en-us/vstudio/default.aspx 

• Windows CE 6.0 R3 Topaz SDK 
Download from http://guruce.com/topaz/release/latest 

  

                                                             
1 Please refer to the “Topaz BSP User Guide” for information on how to create a custom OS Design for the 
Topaz platform. 

Figure 1 - Mini USB 
Type B 

http://guruce.com/topaz/release/latest
http://msdn.microsoft.com/en-us/vstudio/default.aspx
http://guruce.com/topaz/release/latest
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2.1.1 Important Installation Notes 
For a successful installation you need to follow this exact sequence when installing the above items: 

1. Install Visual Studio 2008 
2. Install Visual Studio 2008 Service Pack 1 
3. Install the Topaz SDK2 

a. Double click on the SDK installer file (TopazSDKrXXX.msi where XXX is the release 
version number).  

b. Simply follow the installation wizard and within a few clicks your SDK is installed. 

3 Upgrading the firmware 

3.1 Install Topaz Flasher 
If your Topaz board is not running Windows CE, or you want to update it to a later version, you can 
flash the Topaz with new images by following these steps: 
 

1. Download the flash update application from the GuruCE web site (http://guruce.com/topaz-
flasher) 

2. Download the 32-bit or the 64-bit version of the Topaz Flasher (“Topaz Flasher x86.msi” or 
“Topaz Flasher x64.msi”) depending on your operating system. 

3. Run the installer and Follow the installation wizard: 

 
Figure 2 - Welcome Screen 

Click “Next” on the “Welcome to the Topaz Flasher Setup Wizard” dialog. 

                                                             
2 The SDK is built for use with Visual Studio 2008. Please contact us if you need an SDK built for use with Visual 
Studio 2005 (see also http://guruce.com/blogpost/installing-ce-60-sdks-on-systems-with-only-vs2008-
installed). Unfortunately, VS2010 does not support Smart Device Development (yet). 

http://guruce.com/topaz-flasher
http://guruce.com/topaz-flasher
http://guruce.com/blogpost/installing-ce-60-sdks-on-systems-with-only-vs2008-installed
http://guruce.com/blogpost/installing-ce-60-sdks-on-systems-with-only-vs2008-installed
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Figure 3 – EULA 

Read the GuruCE End-User License agreement. If agreed select the “I accept the terms in the 
License Agreement” checkbox and click “Next”.

 
Figure 4 - Custom Setup 

Here you can customize the setup procedure. By default all options will be installed 
(recommended): 

• Topaz Flasher 
This installs the Topaz Flasher utility. 

• Desktop Shortcut 
This places a shortcut to the Topaz Flasher on the Desktop for easy access. 

• Topaz USB Driver 
This is the USB driver that will allow the Topaz Flasher to communicate with the 
Topaz whilst in “flash mode”. 

 

You can also change the location the Topaz Flasher will be installed to by clicking on the 
“Browse...” button. 

Once you’ve made the selections you like click “Next” to continue the installation procedure. 
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Figure 5 - Ready to install 

Click on the “Install” button to start the installation. 
 

 
Figure 6 - Setup Completed 

Click “Finish” to exit the installation. 

3.2 Connecting the Topaz 
1. Start the Topaz Flasher Utility 
2. If you want to update the firmware on the Topaz development kit you’ll have to put the 

board in “flash mode”. On the back of the Topaz board you’ll find SW1 which is used to 
select the boot mode of the Topaz. Set SW1 as follows: 
 
SW1-1 = ON 
SW1-2 = ON 
SW1-3 = X (don’t care) 
SW1-4 = X (don’t care) 
 
Please refer to sections “Boot Mode Configuration” and “Flash Mode” for a more detailed 
description of SW1. 
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3. Power the board by connecting a mini USB type B cable to the Topaz board and the PC 
where the Topaz Flasher utility is running. 

4. If this is the first time you connect a Topaz board to this particular USB port, the OS will 
notify you a new USB device is detected and it should install the correct Topaz i.MX25 driver 
automatically if you included the “Topaz USB Driver” component when installing the Topaz 
Flasher (see Figure 4 above). 
 
If you haven’t installed the Topaz USB Driver or the Operating System does not automatically 
install the right driver, point 
the “Found new hardware 
wizard” to subfolder “Topaz 
Driver” in the Topaz Flasher 
installation folder (usually 
C:\Program 
Files\GuruCE\Topaz 
Flasher\Topaz Driver”. 
 
If the driver is correctly installed the Topaz Flasher utility will now show “Topaz Initialized”: 
 

 
Figure 8 - Topaz Flasher Initialized 

3.3 Upgrading firmware 
1. Make sure the Topaz board is in flash mode (see “Flash Mode” below) 
2. Double click on the Topaz Flasher shortcut created on the desktop or start the Topaz Flasher 

from the start menu (Start -> All programs -> Topaz Flasher -> Topaz Flasher). 
3. The Topaz flasher will wait until a Topaz board is connected through USB: 

 
Figure 9 - Topaz Flasher waiting for Topaz 

4. If the USB cable wasn’t already connected then connect it to the Topaz and the PC running 
the Topaz Flasher now. The connection with the Topaz board will be established and the 

Figure 7 - Driver Software Installation 
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Topaz will be initialized: 

 
Figure 10 - Topaz initialized 

5. Select the binaries which need to be updated. If you check any of the three checkboxes and 
that binary is not selected in the Flash Settings dialog and that binary is not found in the 
current folder then this dialog will appear allowing you to browse and select the binaries: 

 
Figure 11 - Flash Settings 

You can open the Flash Settings dialog at any time (and change the binaries pointed to) by 
clicking “Flash...” from the “Settings” menu. 
Note that the Topaz Flasher can handle .bin and .nb0 (flat image) files. 
The following is a description of the options: 

• NAND / SD/MMC 
Select NAND if you want to flash to internal NAND flash. Set to SD/MMC if you 
created a kernel for SD and want to flash to SD. Note that you need to make a 
hardware mod to the Topaz DevKit to allow flashing to SD. 

• Verify flash 
If you check this checkbox the flash written to the Topaz will be verified to see if the 
flash contains the expected values. If you check this box upgrading firmware takes a 
bit longer. 

• RTK 
The Runtime kernel is only used when the Topaz i.MX25 is in “flash mode” (see 
“Flash Mode” below). This kernel is uploaded to the Topaz over USB and is 
responsible for setting up SDRAM, initializing flash, erasing flash and programming 
flash. You can think of the RTK being the “USB (& flash) driver” on the Topaz side. 
This option is currently not used but present for future use. 
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• XLDR 
This is the 1st stage bootloader, responsible for setting up SDRAM and launching 
EBOOT. 

• EBOOT 
This is the 2nd stage bootloader, responsible for showing a bootmenu to the user, 
downloading a kernel from Platform Builder, setting up debug connections, 
programming the MAC address, loading and launching the CE kernel from Flash, etc. 

• NK 
This is the Windows CE kernel. 

• Splash 
This is the boot splash image that will be displayed as soon as the Topaz is powered 
up. Bitmap (.bmp), Jpeg (.jpg) and PNG (.png) are supported image formats. The 
image can be any size and will be resized according to the LCD size setting. The 
Topaz Flasher will only scale an image down, never up. 

• LCD size 
Set this to the resolution of the LCD connected to your Topaz. 

• Custom 
These options can be used to flash a custom file into flash. You can use this option if 
you would like to flash a linux bootloader for instance. 

• Save button 
This persists the settings so you don’t have to point to the binaries again the next 
time you use the Topaz Flasher and returns to the main window. 

• Cancel button 
Cancels any changes you’ve made and returns to the main window. 

6. Click the “Flash!” button to upgrade the firmware. 

 
Figure 12 - Flash! 

The progress bar will show progress per file. XLDR will take a very short time to program, 
EBOOT a bit longer and NK will take the longest. 

7. If you see this dialog you’ve successfully upgraded the firmware on the Topaz: 

 
Figure 13 – Programmed/erased succesfully 

8. Set SW1 back to normal mode: 
 
SW1-1 = OFF 
SW1-2 = OFF 
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SW1-3 = X (don’t care) 
SW1-4 = X (don’t care) 
 
Please refer to sections “Boot Mode Configuration” and “Normal mode” for a more detailed 
description of SW1. 

9. Now power-cycle the Topaz and Windows CE should appear shortly (if it doesn’t make sure 
the options in the bootmenu are set to launch the existing image in NAND): 

 
Figure 14 - Topaz Windows CE 

3.4 Boot Mode Configuration Switch 

3.4.1 Normal mode 
In “Normal Mode” the boot mode configuration switch (SW1) has the following settings: 

SW1-1 = OFF 
SW1-2 = OFF 
SW1-3 = X (don’t care) 
SW1-4 = X (don’t care) 

 
See Table 1 and Figure 15 for reference.  
 
 OFF ON  

1 �  

BO
O

T 0 

2 �  1 

3 X X 2 

4 X X GP 1-04 
Table 1 - Normal Mode 
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Figure 15: Boot Mode Configuration Switch (SW1) showing “Normal Mode”  

3.4.2 Flash Mode 
For “Flash Mode” the boot mode configuration switch (SW1) has to be set as follows (see also Table 
2):  

SW1-1 = ON 
SW1-2 = ON 
SW1-3 = X (don’t care) 
SW1-4 = X (don’t care) 

 
 OFF ON  

1  � 

BO
O

T 0 

2  � 1 

3 X X 2 

4 X X GP 1-04 
Table 2 - Flash Mode 

4 Application development 
This contains a step-by-step procedure how to create a simple application for the Topaz i.MX25 
Development Kit.   

4.1 Creating a debug connection 
There are several ways to connect to your device and setup a debug connection. The most 
commonly used debug connectivity methods are ActiveSync or CoreCon. 
 
This tutorial will describe how to connect and deploy via CoreCon. The following files are required on 
the device to be able to use CoreCon for debugging and deploying: 
 
• clientshutdown.exe 
• CMAccept.exe 
• ConmanClient2.exe 
• DeviceDMA.dll 
• eDbgTL.dll 
• TcpConnectionA.dll 
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The standard Windows CE image for the Topaz module already includes these files so you can 
immediately start developing applications using Visual Studio 20083. 
 
If you are creating your own kernel image you’ll have to make sure these files are copied onto the 
target. You can either include them in the image (by adding entries to project.bib for instance) or by 
copying them to the CE device through FTP or ActiveSync. 
The needed files can be found in the following directory (after installing Visual Studio 2008): 
%ProgramFiles%\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\ armv4i.  

4.2 Creating a Simple C# Application 
This example will show you how to create a simple managed C# application targeting the Topaz 
using Visual Studio 2008. 

4.2.1 Creating your application 
1) Open Visual Studio and select New | project from the File menu. 
2) Navigate to the Visual C# language and select the Smart Device project type.  

 
Figure 16: New Project 

 
3) Name the solution DemoAppManaged and select OK. Visual Studio will generate the 

necessary files. 
4) Make sure Topaz is selected as your target. If it is not selected, right click on the 

DemoAppManaged project and select Change Target Platform. In the pop-up dialog select 
the Topaz SDK. 

5) Figure 17 shows the generated files. 

                                                             
3 Please refer to the “Topaz BSP User Guide” for details on how to create a Windows CE kernel that includes 
the correct files for debugging with Visual Studio 2005. 
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Figure 17: DemoAppManaged 

4.2.2 Setting up the connection 
1) Power up the Topaz 
2) When the system has booted you’ll need to get the IP address of the Topaz. There are 

several ways to do this: 
• Double click the network icon in the lower right corner and check the detailed view 

for the IP address, -or- 
• On the target’s command line (start | Run | cmd.exe) run ipconfig.exe, -or- 
• Configure a static IP in the boot loader menu (see “Configure Topaz to use a static IP” 

below), -or- 
• Check the list of assigned IP addresses in your DHCP server, -or- 
• Check the ARP table on your router 

3) Click on menu Tools in Visual Studio. Select Options and browse to Device Tools -> Devices.  
4) In the Options dialog select the Properties for the Topaz SDK ARMV4I Device (see Figure 18) 

 
Figure 18: Configuring Connectivity Options 

5) In the Topaz SDK ARMV4I Device Properties window select Configure 
6) In the Configure TCP/IP Transport dialog select Use specific IP address and enter the IP 

address of the Topaz retrieved in step 2) above 
7) Select OK 3 times to get back to the solution 
8) On the Topaz Target start: 

1. Conmanclient2.exe  
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2. CMAccept.exe 
You can start these programs through telnet or by clicking Start -> Run on the device. Note 
that if using Telnet you will need to open two telnet windows (since ConmanClient2 does 
not return). 

9) Now you need to connect to the target within 2 minutes (otherwise you’ll have to start 
CMAccept again). In Visual Studio click Connect to Device on the Tools menu: 

 
Figure 19: Connect to Device 

10) You are now connected to the Topaz device. 

 
Figure 20: Connection succeeded 

4.2.3 Debugging your application 
To start debugging your application press F5 or navigate to the Debug menu and select Start 
debugging. The application will start running on the Topaz.  You can set breakpoints and view 
variables in the same way as you would in a normal desktop application. 
 

4.2.4 Accessing hardware from your application 
The Topaz SDK contains headers and libraries for direct access to hardware from your application. 
Headers and libraries are provided for ADC, CAN, SPI, I2C, GPIO, GPT and PWM. The headers in the 
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SDK are for use in native code but managed code (C#) wrappers are available as well. Please contact 
GuruCE for more information. 

4.3 Configure Topaz to use a static IP 
This section describes how you can configure the Topaz Development Kit to use a static IP. This can 
be useful when you’re targeting a Topaz board without a display4. 
 
The bootloader menu contains items that can be used to configure the IP settings of the Topaz 
device. 

4.3.1 Serial connection 
1) Connect Serial RS232 a null-modem cable between the Topaz development kit and a PC 
2) Open your favorite terminal (like HyperTerm or TeraTerm for instance) and setup a serial 

connection at 115,200 baud, 8 data bits, no parity, 1 stop bit and no flow control 
3) Power the board and the following message should appear on your terminal: 

 
 

4) Hit space to enter the boot loader menu. The following menu will then appear on your 
terminal: 

                                                             
4 In this case a small application that outputs the IP address on the serial port at boot-up is another solution to 
get easy access to the IP address of a headless device. 

Microsoft Windows CE Bootloader Common Library Version 1.4 Built Apr 13 2010 13:48:31 
Microsoft Windows CE Ethernet Bootloader 1.0 for MX25 3DS (Apr 13 2010 14:05:08) 
INFO:  Bootloader launched from NAND 
INFO: OEMPlatformInit: Initialized NAND flash device. 
INFO: Loading boot configuration from NAND 
System ready! 
Preparing for download... 
 
Press [ENTER] to launch image stored in NAND flash or [SPACE] to cancel. 
 
Initiating image launch in 2 seconds. 
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5) Press ‘0’ and enter the IP address, eg. 192.168.1.100 
6) Press ‘1’ for configuring the IP mask, eg. 255.255.255.0 
7) Press ‘2’ for entering the gateway, eg. 192.168.1.1 
8) Press ‘4’ to toggle the use of DHCP. Make sure DHCP is disabled 
9) When done, press ‘S’ to save the settings to NAND 
10) Press ‘L’ to launch the image using the new IP settings 

 
For a complete description of the Boot loader and the boot loader options please refer to the “Topaz 
BSP User Guide” available on the GuruCE Topaz download page: 
http://guruce.com/topaz/release/latest 

  

----------------------------------------------------------------------------- 
Topaz i.MX25 Boot Menu 
----------------------------------------------------------------------------- 
 [0] IP Address : 0.0.0.0 
 [1] Set IP Mask : 0.0.0.0 
 [2] Set Gateway : 0.0.0.0 
 [3] Set MAC Address : 0-50-C2-3F-90-6A 
 [4] DHCP : Enabled 
 [5] Boot Delay : 3 
 [6] Select Boot Device : NK from NAND 
 [7] Reset to Factory Default Configuration 
 [8] Format OS NAND Region 
 [9] Format All NAND Regions 
 [C] Clean registry & databases : Disabled 
 [B] Bootloader Shell 
 [W] KITL Work Mode : Interrupt 
 [K] KITL Enable Mode : Disabled 
 [P] KITL Passive Mode : Disabled 
 [E] Select Ether Device : FEC 
 [U] Select Windows CE Debug UART : Disabled 
 [D] Download Image Now 
 [L] Launch Existing Flash Resident Image Now 
 [M] MMC and SD Utilities 
 [R] Reset 
 [S] Save Settings 
 
 Selection:  
 

http://guruce.com/topaz/release/latest
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5 About us 

5.1 GuruCE  
GuruCE offers deep technical knowledge of the Windows Embedded CE (Windows Embedded 
Compact Edition) operating system. The consultants of GuruCE are among the best in Windows CE 
BSP & driver development, training and consulting. 

GuruCE can help you and your company get to market faster by taking care of all the Windows CE 
low-level issues so that your experts can focus on what they do best, or we can teach you how to do 
it yourself through training by one of our consultants. We can help you with general system design 
(both hardware & software), application design & development, real-time embedded design issues 
and driver development. 

5.2 Blog 
For tips & tricks on Windows CE and other related issues please have a look at our blog: 
http://guruce.com/blog. 

5.3 Support options 
GuruCE offers various support options. Please visit http://guruce.com/support for more information. 

 

 

 

 

 

 

 

 

 

GuruCE APAC/NZ 

Contact : Michel Verhagen 
Email : michel@guruce.com 
Phone : +64 (0)7 929 5807 
Mobile : +64 (0)21 104 6208 

240 Ohiwa Harbour Road 
RD2, Opotiki, 3198 
New Zealand 

GuruCE EMEA/NL 

Contact : Erwin Zwart 
Email : erwin@guruce.com 
Phone : +31 (0)728 503 119 
Mobile : +31 (0)629 512 116 

Tuin van Halo 19 
Heerhugowaard, 1705 TD 
The Netherlands 

http://guruce.com/blog
http://guruce.com/support
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